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The basics of
AdminPlus 6 Redi      Kards

Quick Help at Your Fingertips

This Redi-Kard will get you started with AdminPlus 6 and its different modules, helping you learn some of the most basic tasks you 
may do every day. Some of these tasks include: taking and importing attendance, finding students, demoting a student, changing a 
grade level of a student, scheduling, and customizing Lookup to help find the information you need quickly. 

The main screen consists of the toolbar, Shortcut Bar, School and Year drop-downs, User and Version information, and the Program 
Background. There are several ways to navigate, but the most popular methods are right-clicking, the toolbar, and the Shortcut Bar.

Navigation

Quick Launch Icons
Launch your favorite tasks, AdminPlus Notify, and School Dashboard  
(with information such as attendance, incidents, and trends in attendance).

Shortcut Bar
Access different programs within a module. Clicking the module name opens the menu for that module. All programs within 
the module can be accessed by clicking the appropriate icon. To change the size of these icons, click View > Shortcut Bar, and 
choose Large Icons, Small Icons, or None.

Hot Keys
Hot Keys enable you to jump from module to module 
while viewing the same student’s data. From left to 
right are the Hot Keys for the following modules: Data 
Base Plus, Attendance Plus, Report Cards, Scheduling, 
Discipline, Billing, Pictures Plus, Period Attendance, and 
Fast Payments. 

Toolbar
Access the different modules and programs.

Right-Click Menu
Right-click anywhere on the program’s 
background to access task-based commands 
(for example, view a student’s grade).

Shortcut Icons
Shortcut icons enable you to quickly access the selected 
student’s portfolio and household; configure the Address 
screen; print or modify the selected student or staff 
member’s data report; send the current demographic view 
to Excel; and receive data from PlusPortals, APWeb, and 
Online Forms.

Current User and Version
Your version of AdminPlus and user name appear at 
the bottom of the screen.

Program Background
This is the main work area within AdminPlus. 
Program windows appear in this main area.
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The Data Base (DB) module is where you add, inactivate, 
reactivate, and/or delete students and staff. It is also where all 
demographic data is entered for students and staff. The main 
programs in Data Base are New Files, Address, and Print.

New Files

       Add a Student or Staff Member

1.	 On the startup screen, right-click > New > Student > 
Manual Entry.

2.	 Click a grade level, and then click Select.
3.	 Type the Last Name, First Name, and Middle Name.
4.	 Verify that the information in the Entry Date, Entry Code, 

and Language fields are correct.
5.	 Click Next [F10].
6.	 Use a new Household ID, or link to an existing one.
7.	 Click Add this Member, click Next, and then click Done.
       
        Inactivate a Student or Staff Member

1.	 On the Home screen, click a student or staff member.

2.	 Click the Inactivate Icon         in the Snapshot area.
3.	 Click Inactivate this member, and then click Next.
4.	 Click Done.
5.	 To reactivate a person, repeat steps 1 and 2, and select 

the Reactivate this member option. 

        Delete a Student or Staff Member

Deleting a student or staff member completely removes 
the person from the school year in which he or she was 
deleted. However, the individual remains in the past years. 
Furthermore, you cannot delete a student with billing data.

1.	 In the Data Base module (Shortcut Bar), click New Files.
2.	 Click Lookup on the left, find and click the student, and 

then click Select.
3.	 Click Delete on the left, and confirm the deletion.

        Promote or Demote an Individual Student

These steps should only be followed when you need to 
promote or demote an individual student. You can use the 
Beginning program in the Data Base module to mass promote 
your students once you’ve created a new school year. 

1.	 In the Data Base module, click New Files.
2.	 Look up the student.
3.	 Click Other [F9].
4.	 Click Move to another ID and/or grade Level, and click 

Next.
5.	 Select the appropriate grade level (and ID), and click Next.

       Find a Student by any Demographic Field 

1.	 On the Home screen, click Students or Staff, based on 
what demographic group you wish to search in.

2.	 Do one of the following:
•	 Click Begins With if searching using the first three 

characters contained in the person’s information for the 
selected demographic field (e.g. Name).

•	 Click Contains if searching using any characters contained 
in the individual’s information for the field.

3.	 Type the student or staff member’s information in the text 
box, and click the search icon      (or press the Enter key). 

4.	 If searching for someone by using a demographic field 
other than Name, click the column heading label by which 
you would like to search for the person (for example, 
APID or Grade).

With Lookup, you can search for students or staff using their 
name, ID, or any demographic field displayed. 

The New Files 
program is where 
you add, inactivate, 
reactivate, or delete 
students or staff, and 
demote or promote 
students.

Finding Students

F9 Print: Generate Quick Reports

The F9:Print key icon           is found to the far right (together 
with other shortcut keys) of most student data entry screens. 
Clicking this key generates the default report for the current 
screen. You can customize this feature to generate a specific 
Report Writer report for the selected student upon clicking. 
For example, you can configure this print feature in the  
View/Change program in Report Cards to generate a report 
card or transcript instead of the default report.

        Customize F9 Print

1.	 Click any data entry screen (e.g. Report Cards > View 
Change).         

2.	 Select a student.
3.	 Right-click the Print icon, and click Change (task name). 

Note: Depending on the data entry screen, the right-click 
option may also display as Custom Report.

4.	 Select a report writing task to set as the new default 
report for that screen, and click Select. 

Now when you click the F9:Print icon from that screen, the 
report associated with the selected task will be generated. 

Data Base Module
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Address
The Address program is where you enter or edit demographic 
data for students and staff. Address contains 260 fields on 13 
pages (20 fields per page) that can be used to store data. 

        Enter or Edit Student or Staff Demographics

1.	 In the Data Base module (Shortcut Bar), click Address.
2.	 Double-click a student or staff member. 
3.	 Enter or edit the data. Use the tabs at the top of the 

demographic fields area to enter data on other pages.
4.	 Click Accept [F10] to save your changes. 

        Batch Enter Student Demographic Data

1.	 On the Home screen, click the Other Options icon                  
on the right.

2.	 Click Batch Entry.
3.	 Do one of the following:

•	 Click Grade number, click a specific grade from the list, 
and then click Next.

•	 Click All grades, and then click Next.
4.	 Type the data to be batch-entered into the appropriate 

database field(s).
5.	 Click Accept [F10].
6.	 Click one of the 

following options, 
depending on 
whom you want to 
batch enter data 
for, and click Next:
•	 Individual 

members/
groups: Enables 
you to select 
individual students who are to have the data entered into 
their records.

•	 All members: You can batch enter data for everyone in 
the grade(s).

•	 Members matching a data base criteria (query): 
Have AdminPlus find specific students based on another 
database field to apply the batch entry to.

7.	 Click Accept [F10].
8.	 Once completed, click Abort [Esc] to get back to the 

Address screen and verify that the batch entry was 
successful.

Print Program 
With the Print Program, you can quickly generate a list, such 
as for a homeroom or a team.

        Generate a Report Using the Print Program

1.	 In the Data Base module, click Print Prog.
2.	 Click a report type:

•	 One column with additional fields enables you to 
generate a list containing Student Name, ID, or any other 
database fields (such as Homeroom and Phone).

•	 Three columns generates a report of student names and 
IDs displayed in three columns.

•	 Totals only creates a report with just totals, no names.
3.	 If you click either of the one-column options, do the 

following:
•	 Hold down the Ctrl key and click any of the fields on the 

left to be included in the report.
•	 Click the arrow pointing to the right to select the fields, 

and then click Accept [F10].
•	 Click one of the print options for additional fields 

(Columns, Rows, or ASCII file), and then click Next.
4.	 Click a specific grade number, All grades, or Staff, and 

then click Next.
5.	 Click one of the options that determines which students 

to include in the list, and then click Next:
•	 All Students lists them alphabetically.
•	 Individual Students enables you to select certain 

students to be included in the list. 
•	 Search by One Field enables you to group students or 

staff by database field entries. Select a database field, 
and the program will search for all entries based on the 
selected field and generate a printout for each unique 
entry. 

•	 Search by Field(s) (query) allows you to search for 
students who meet certain criteria. 

6.	 After the list is generated, click Print at the bottom right, 
and follow your printer’s instructions.

Attendance Module 
The Attendance module is where you enter or edit student 
attendance. The main programs in Attendance covered in this 
card are Enter Daily, Batch Entry, and Correct.

Enter Daily
The Enter Daily program enables you to enter student atten-
dance on a daily basis. You can enter attendance manually, or 
you can import attendance from TeacherPlus Gradebook,  
GradeQuick, or APWeb Teacher. The Enter Daily program is 
also where you can add the current day to your attendance 
calendar as well as where you can print the daily attendance 
bulletin. 

        Add “Today” to the Calendar

You will be building your calendar daily as you take attendance.

1.	 In the Attendance module (Shortcut Bar), click Enter Daily. 
(Shortcut: right-click > Enter > Daily Attendance.)

2.	 Read the warning, and click Yes.
3.	 Confirm the date and membership value, and click Next.

???

???

???

???
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        Manually Enter Student Attendance

1.	 In the Attendance module, click Enter Daily.  
(Shortcut: right-click > Enter > Daily Attendance.)

2.	 Create “today” if you have not already done so. (See the 
previous instructions.)

3.	 Click Manual Entry, and then click Next.
4.	 Click a grade level from the Default Grade list.
5.	 Type the student’s APID in the ID column, or click Lookup 

[F6] at the bottom to locate the student.
6.	 Type the applicable attendance code in the Code 1 column, 

and then click Accept.

        Import Attendance

You can import attendance into AdminPlus from the TeacherPlus 
Gradebook, GradeQuick (GQ), PDA, or APWeb Holding Bin.

1.	 In the Attendance module, click Enter Daily.  
(Shortcut: right-click > Enter > Daily Attendance.)

2.	 Create “today” if you have not already done so. (See the first 
FAQ in this section.)

3.	 If importing attendance from GQ, PDA, or APWeb,  
click 9. Receive from GQ/PDA/APWeb Holding Bin.

4.	 If importing attendance from Gradebook, click  
B. Receive From TeacherPlus Gradebook.

5.	 Verify that you have the correct import template(s) selected, 
and then click Next.

6.	 After the Holding Bin appears with your attendance files, 
select the files you want to import, and then click Receive 
Attendance to continue importing.

7.	 Once the import process is complete, close the log, and click 
Exception List to get a list of teachers who have not submit-
ted attendance (GQ, PDA, APWeb only).

        

        Print the Daily Attendance Bulletin

1.	 In the Attendance module, click Enter Daily.  
(Shortcut: right-click > Enter > Daily Attendance.)

2.	 Import attendance or enter attendance manually.
3.	 Click 6. Print Bulletin, and click Next.
4.	 After the report is generated, do either of the following:

•	 Click Print to generate a paper copy of the report.
•	 Click Convert to PDF to make a PDF of the report, which 

can be emailed to staff or accessed in a central location.

Batch Entry
The Batch Entry program enables you to enter the same 
attendance codes for a  group of students.

        Batch Enter Attendance Codes

1.	 In the Attendance module, click Batch Entry.
2.	 In the Specifications dialog box, set the following specifica-

tions, and then click Done:
•	 For spec 1, set the date 

for when the atten-
dance code will be 
entered.

•	 For specs 2 and 3, 
select an attendance 
code and an  
optional time.

•	 For specs 4 and 5, 
enter a second code and time.

•	 For specs 6 and 7, set the start and end grade levels.
•	 For spec 8, select a type of student for whom you want to 

enter the code.
3.	 Click a specific grade from the Grade list, or click All Grades.
4.	 Click one of the following options, depending on your batch 

entry needs:
•	 All students: Enables you to batch enter the code for 

everyone in the grade(s).
•	 Individual students/groups: Lets you select individual 

students for the batch entry.
•	 Students matching your DB criteria (query): Allows 

you to find specific students (based on data in a particular 
database field) who will get the batch entry.

5.	 Click Next to begin the batch entry and write the code(s) to 
the students’ attendance records.

Correct
The Correct program is where student attendance data is stored. 
You can view, enter, and edit attendance data from this screen. 
There are three different attendance views:
•	 Calendar View: Shows student attendance data day by day. 

All corrections are made in this view.
•	 Register Code View: Shows student attendance by Register 

Codes. A Register Code is a summary code that describes the 
“what” of the attendance status (i.e. Absent, Tardy, etc.).

•	 Attendance Code View: Shows student attendance by 
Attendance Codes. An Attendance Code is a detail code that 
describes the “why” of the attendance status (i.e. Absent 
Excused, Tardy Unexcused, Absent Medical, etc.). 

???

???

???

???
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        Edit an Individual Student’s Attendance 

1.	 In the Attendance module, click Correct.  
(Shortcut: right-click > View/Edit > Daily Attendance.)

2.	 Make sure the Calendar View option is selected on the left.
3.	 Click Lookup [F6] on the left, find and click the student, and 

click Select.
4.	 Click Edit [F3] on the left.
5.	 Type the code manually, or click Code Lookup [F6] to find 

the appropriate code.
6.	 Click Accept [F10].

        Enter an Attendance Comment 

1.	 In the Attendance module, click Correct.  
(Shortcut: right-click > View/Edit > Daily Attendance.)

2.	 Click Lookup [F6] on the left, find and click the student, 
and click Select.

3.	 Click the day to be associated with the comment, and 
then click Comments [F12] on the left.

4.	 Type the comments, and click Accept [F10].

Report Cards 
The Report Cards module enables you to add courses and 
sections, enter and edit student grades, run honor rolls, and 
perform other similar report card features. The main  
programs in Report Cards covered in this card include Enter 
Courses, Enter Grades, Statistical Reports, and  
View/Change/Add/Drop. 

Enter Courses
The Enter Courses program is where you add courses and 
sections to AdminPlus. A course is a class or subject (e.g. Algebra 
1), and a section is a meeting time, teacher, and room of a 
course (e.g. Section 1 of Algebra 1 meets “A” block in room 112, 
and it is taught by Ms. Smith).

        Add a Course

1.	 Right-click > New > Course.
2.	 In the Select Course 

Number to Add dialog 
box, click an **UNUSED** 
course number, and then 
click Select.

3.	 Fill out the appropriate 
course information, and 
click Accept [F10].

        Add a Section

1.	 In the Report Cards module, click Ent. Courses.
2.	 Click 1. View/edit courses & sections, and click Next.
3.	 Click Lookup [F6] on the left.
4.	 Find and click a course, and click Select.
5.	 Click Section [F2] at the top left, and then click Add [F2].
6.	 Enter the Teacher ID, Meeting Time, and Room Number.
7.	 Click Exit [Esc] when you have added all desired sections.

        Print a Course or Section List

1.	 In the Report Cards module, click Ent. Courses.
2.	 Click 1. View/edit courses & sections, and click Next.
3.	 In the View/Edit Courses And Sections dialog box, click 

one of the following print options, and make a selection to 
generate the report:
•	 Print Courses: Print a master course list by course 

number, course name, or by courses with skills.
•	 Print Sections: Print a section list by course/selection 

(CRS/SC), staff, time, course name (CRS Name), or room.
4.	 Select what you want to print, and the report will be 

generated on your screen.

Enter Grades
The Enter Grades program is where you can enter student 
grades. Grades can be entered manually by roster (i.e. section), 
or they can be imported. 

        Enter a Grade Manually

1.	 In the Report Cards module, click Ent. Grades.  
(Shortcut: right-click > Enter > Grades.)

2.	 Click 1. Enter grades manually, and click Next.
3.	 Set your desired specifications, and click Done.
4.	 Click Lookup [F6] on the left, click a course, and click Select.
5.	 Click Edit [F3] on the left.
6.	 Type each grade in its corresponding cell, and then click 

Accept [F10].

         Import Grades from TeacherPlus Gradebook

1.	 In the Report Cards module, click Ent. Grades.
2.	 Click 6. Receive from TeacherPlus Gradebook, and then 

click Yes to sync AdminPlus with Gradebook.
3.	 Click a marking period in the Current Marking Period list.
4.	 Click the section(s) you want displayed from the Display 

Sections Meeting When list.
5.	 In Gradebook Columns, select the check box for each 

grade column to be imported from Gradebook.
6.	 In AdminPlus Report Card Columns, make sure each 

report card column matches the desired Gradebook column 
on the left. The grades from each Gradebook column you 
selected in step 5 will be imported to its corresponding 
adjacent report card column.

7.	 Click Next.
8.	 Do one of the following:

•	 To receive grades teachers have not officially 
submitted, click Except NA at the upper-right corner.

•	 To receive grades teachers have officially submitted, 
click Ready at the upper-right corner.

9.	 Select the check box for each gradebook you wish to 
import grades from.

10.	 Click Save Grades from Selected Gradebooks.
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        Import Grades from GradeQuick (GQ)

1.	 In the Report Cards module, click Ent. Grades.  
(Shortcut: right-click > Enter > Grades.)

2.	 Click 4. Receive from Grade Quick.
3.	 Set your desired import specifications, and click Done.
4.	 Click 1. Receive all sections or 2. Receive individual 

sections.
5.	 Set the quarter from the drop-down list, verify the start 

grade, end grade and receive data by date, and then click 
Done.

6.	 Once the import is complete, close the log, and click  
6. Teacher exception list to get a list of teachers who have 
not submitted grades yet.

         Import Grades from APWeb Teacher

1.	 In the Report Cards module, click Ent. Grades.  
(Shortcut: right-click > Enter > Grades.)

2.	 Click 5. Receive from APWeb Teacher.
3.	 Select the check boxes for the section(s) you want to import 

grades from, and then click Receive from Holding Bin.
        A log appears after the import is complete. 

Statistical Reports (Stat Reps)
The Statistical Reports program is used to run honor rolls and 
calculate GPAs. 

        Run Honor Rolls

1.	 In the Report Cards module, click Stat Reps. (Shortcut: right-
click > Print/E-Mail > Report Cards > Stat Reps.)

2.	 Click 1. Honor Rolls, and click Next.
3.	 Click 1. Print honor roll #1, and click Next.
4.	 Set your honor roll specifications, and click Done.
5.	 Select to run the honor roll for a grade level or all grades, or 

do an individual student audit to find out why a particular 
student made (or did not make) a specific honor roll.

6.	 Once the honor roll is generated, you can print it by clicking 
the print icon (shortcut key: [F9]) at the bottom right.

Note: Always run honor rolls in order (honor roll 1 first).

View/Change/Add/Drop (VCAD)
The View/Change/Add/Drop program is where student grades, 
GPA, and schedule information are stored. VCAD enables users 
to toggle between the transcript (e.g. Report Card)  functions 
and schedule functions—even if your school does not own 
Scheduling. In the left-hand menu, you 
will see three different view options. 
Click any of the radio buttons to toggle 
between the different views.

        Enter an Individual Student’s Grades

1.	 In the Report Cards module, click View Change.  
(Shortcut: right-click > View/Edit Grades.)

2.	 In the View Transcripts dialog box, make sure the option 
Transcripts is selected at the upper-left corner.

3.	 Look up the student.
4.	 Click a course, and then click Edit [F3] on the left.
5.	 Enter the grade(s) in the appropriate cells, and click Done at 

the bottom right.

        View a Student’s GPA 

1.	 In the Report Cards module, click View Change.  
(Shortcut: right-click > View/Edit Grades.)

2.	 Look up the student.
3.	 View the GPA information located at the top of the View 

Transcripts dialog box under the student’s photo.

Scheduling within VCAD

Within VCAD, you can schedule students into courses and 
sections. This could be as easy as changing a student’s section or 
course, scheduling one student into all of his or her courses, or 
block-copying a schedule from one student to all other students 
in the same homeroom (or team). 

        Add a Student to a New Course/Section

1.	 In the Report Cards module, click View Change.  
(Shortcut: right-click > View/Edit Grades.)

2.	 Click Line Schedule on the left.
3.	 Look up the student.
4.	 Right-click anywhere in the schedule table, and then click 

Add New Course/Section.
5.	 In the Select a Course/Section dialog box, click a course, 

and click Select.

        Withdraw a Student from a Course or Section

1.	 In the Report Cards module, click View Change.  
(Shortcut: right-click > View/Edit Grades.)

2.	 Click Line Schedule on the left.
3.	 Look up the student.
4.	 Right-click the course to withdraw the student from, and 

then click Withdraw this Section.

        Speed Schedule a Student

Speed scheduling is primarily used in high schools when a 
student has transferred into the school after the start of school. 
Speed scheduling enables you to select the courses the student 
will take, and AdminPlus will schedule the student into the best 
sections for his or her requested courses. 

1.	 In the Report Cards module, click View Change.  
(Shortcut: right-click > View/Edit Grades.)

2.	 Click Line Schedule on the left.
3.	 Look up the student.
4.	 On the left, click the plus sign (+) next to New to expand it, 

and then click one of the following:
•	 Manual Add [F2]: Requires entering the course numbers.
•	 Courses [F3]: Enables you to select courses from a list.

5.	 Once you have selected all the courses, click the plus sign (+) 
next to All Courses & Requests, and then click Speed Sch. 
to have the student be scheduled into all available courses.

???

Need more help?
Visit redikersupport.com to browse documentation and 
videos, interact through discussion forums, get product 
updates, and contact support.
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